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ACCELERATOR USER GUIDE 

Accelerator is a third-party add-in providing an integration between Outlook and Sage CRM. You can 

update CRM data from Outlook: convert emails to companies, contacts, sales and cases. With 

Accelerator, you can file emails, attachments and log call information as well as tag outbound emails 

to customer service issues, jobs or opportunities. Accelerator is a great tool that provides an 

alternative to the standard Sage CRM Outlook Plugin.  
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Install Accelerator 
Please watch this video which explains steps 1-8: https://www.screencast.com/t/C17CCHOHXlPd  

1. Close Outlook.  

2. Log on to Sage CRM and click on the Accelerator tab. 

3. Select Outlook to download and install the integration. 

 

4. Click Run and follow the install instructions.  

5. When asked if you want to install for all users, click No.  

 

6. Select CRM Settings 
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7. Confirm your CRM path and user/password (these should default into the fields). Select Test. 

 

8. If all settings are correct, you will receive a Logon Succeeded message.  

 

Click Ok. 

9. Once the installation is finished, open Outlook. The Accelerator icon will be in the top right corner of 

the Home tab:  
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Accelerator Settings 
Click Settings in the Home tab 

 

1. Settings 

 

Please note:  

If your corporate policies allow the use of Microsoft Outlook via the Internet and your Sage CRM instance 

is publicly accessible, it is recommended to use the public launch path for your Sage CRM. 

INTERNAL: http://yourCRMServerName/crm/eware.dll/go 

EXTERNAL: http://crm.yourdomain.com/crm/eware.dll/go 
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2. Documents 

 

a. Version Information 

b. Browser 

The default setting is for IE, but if you use a different browser, you can change this by selecting 

‘Default Browser’ 

c. Tagged 

The default setting is for tags to be inserted into the email subject. You also have the option to 

add the tag to the email body instead of the subject. (See Accelerator Menu Buttons – 

Options for more details.) 
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d. Clear Data Cache 

Occasionally, the data cache needs to be cleared for troubleshooting purposes. If the clear 

fails, it can be cleared manually: 

 

 

3. Integrated Access 

Recommended user settings: 
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a. Integrated Access Settings 

CRM User Name/Password = Your Sage CRM login username and password 

Outlook Save Mode = determines whether Accelerator automatically prompts the user to file 

outgoing emails in CRM or if the filing in CRM takes place manually 

b. Logon Credentials 

Use IIS AutoLogon (Default Credentials) 

c. Default Options 

Email Save Prompt = determines whether the storage dialog box is used when saving emails 

Link Outlook Appt Tasks = extends the MS Outlook appointment and task function by enabling 

the option to select, add and link CRM companies, persons and subjects to a process. (This 

function must be previously activated and set up on the server by our technicians.) 

Make Subject Save Default = determine whether only the email message subject or the 

message subject and message content is saved as a suggestion in the dialog box 

Add Attachments Default = allows the user to store email attachments in the CRM document 

library and sets the storage of attachments to ‘active’ in the dialog box  

Add Embedded Images Default = allows the user to specify whether they save embedded 

images within the email 

Activate for Tags = opens the Accelerator pane (if closed) when a tagged email is selected 

Open Menus on MouseOver = opens the menus on mouseover instead of having to click 

Email Save File = saves the email as a file (*.msg) in CRM (this function is only available if 

‘Email storage entry’ has been previously disabled) 

Auto Save Incoming Selected Email = automatically saves incoming emails in CRM upon first 

reading without use of the storage dialogue box 

Save on Sent = automatically saves sent emails in CRM upon sending without use of the 

storage dialogue box 

Reopen Options if CRM password is incorrect = dialog box prompting the entry of login 

information in case of unsuccessful connection to the CRM system 

Auto-save Tagged Emails = automatically save selected email if it is tagged 

File using Custom Fields = enables editing custom fields before filing mail to CRM 
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d. Other Settings  

Default check attachments Size (KB) – indicates a minimum size of attachment that will be 

saved . . . some email signatures contain logo files you don’t want to file 

Delay (ms) before searching CRM for related items – delay of the automatic CRM search (this 

allows the automatic search to be delayed in case of very fast navigation and email clicks; 0 = 

disabled) 

Delay (ms) before dismissing error dialogs – reaction time for error messages and 

unsuccessful search results (0 = no display of unsuccessful search results/display of error 

messages only) 

 

4. Address Management 

Specifies for which email recipients automatic CRM storage and the automatic storage dialog box 

should not be enabled. 

    

Please note: the list of excluded recipients can easily be expanded to include additional recipients by 

right-clicking on an email. Use the function: Ignore Email Address. 
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Viewing Accelerator on the Outlook Screen 
1. Layout 

To change the layout of the Outlook screen to accommodate the addition of the new Accelerator 

panel, select the View tab and click on Reading Pane and choose Bottom 

 

 

Sample Outlook Layout: 

 

2. CRM Status – Filed (Display in Outlook) 

 

To display if the email has been filed using Accelerator: 

Note: This status field is only displayed after the first email has been saved/stored in CRM and is then 

available for setup as described above.  

a. Select the View tab 

b. Click on Add Columns: 
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c. Choose User-defined fields in Inbox from the available columns drop-down and select CRM 

Status. 

d. Select Add and then move the CRM Status field toward the top of the list. 

    

Note: this has to be done for each saved folder (ie. Inbox, Sent Items, etc). To create a new view that 

allows the status field to display in all subfolders, please watch: 

https://www.screencast.com/t/EXBvb11iK. 

Accelerator Menu Buttons 
1. Search Results 

Allows you to search for an entity or use your bookmarks and save any email against any existing 

record.  

Entities – choose the entity  
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Enter part of entity description in the search box and select Go. 

 

To view the record from the grid just double click on the line item. This will then open the Details tab 

and show you the entity page. 

2. Details 

a. New  

Option allows you to create a new Entity based on the data in the email 

Note: while you can create a new case, person or opportunity from here, a best practice is to first 

go to the correct company or person record. 

 

b. Save Email 

Allows you to save the email as a communication ‘Email In’ against the current record . . . see 

Incoming Emails 
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c. Options 

 

Save Attachments – allows you to save only the attachments and not the email. Be sure to change 

the Document Description accordingly as it defaults with the email subject. 
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Sticky – freeze the Accelerator panel on a record. This is practical because you can then assign 

multiple email messages to that CRM context without the panel changing during the automatic 

CRM search after each selected email. Freezing is indicated by a blue frame around the context 

screen and must be manually released by re-selecting Sticky.  

  

 

Phone – view the phone information and enter incoming/outgoing calls (added to CRM as a 

communication record) 

 

Note: Calls can be made if the "callto:" function is supported by your CTI system (Ex. Skype). 

 

To record a communication, click on ‘Type Phone In notes’ or ‘Type Phone Out notes’ button and fill 

in the details of the call.  

 

 

  

http://www.mycrmmanager.com/


 

 

 
 

www.mycrmmanager.com   Page 15 of 26 
 
 

 
 

Tag Email – adds a reference number to the subject line which serves to create and open the 

associated reference in case of incoming emails from the reference (Example: you receive an email 

that needs to reference an existing CRM case. Search for the company and then select the Case 

icon. Find the case and then click on Tag Email. The case number will be referenced in the email 

subject line.) 

 

 

Reply and Tag - opens the Outlook dialog box for replying to an email. The Accelerator pane will 

already be open in the dialog box for the reply email and display the reference context from the 

main screen. The reference ID (tag) is added to the subject line, which serves to create and open 

the associated reference in case of incoming emails from the reference and for other users within 

the organization. 

 

 

Reply All and Tag - opens the Outlook dialog box for replying all to an email. The Accelerator pane 

will already be open in the dialog box for the reply email and display the reference context from 

the main screen. The reference ID (tag) is added to the subject line, which serves to create and 

open the associated reference in case of incoming emails from the reference and for other users 

within the organization. 
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New Email – opens the Outlook dialog box for creating a new email. The Accelerator pane will 

already be open in the dialog box for the new email and display the reference context from the 

main screen. The reference ID (tag) is added to the subject line, which serves to create and open 

the associated reference in case of incoming emails from the reference and for other users within 

the organization. 

 

 

 New Appointments 

From Outlook menu bar: New Appointment or New Task 
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The Outlook entry screen is extended with Sage CRM fields that are preset with entity data from the 

context screen: 

 

 Fill in the CRM fields, search for the entity the appointment/task is relevant to and save.  

Accelerator menu button: New appointment/task 

This function must be previously set up and activated for Accelerator on the Sage CRM server as well 

as in the user settings. The parameters for appointment/task synchronization must be set correctly in 

the Sage CRM server settings! 

New Task 
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Incoming Emails 
1. Email matching  

When an email is received, Accelerator will search on the email and display the person details.  

Accelerator attempts to match the email in the following order: 

a. Tag match – check that there is a tag and if so, search CRM based on that. 

b. Email Person – check for person with same full email address 

c. Email Company – check for a company with matching email domain 

 
2. Saving Emails 

a. Click email to select 

b. Confirm the context is correct 

c. Select Save Email button on Accelerator menu bar 

 

If the Email Save Prompt default option is selected, the dialog box appears. There are 2 tabs in the dialog box: 

Filed for and Doc Settings.  
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a. Filed For 

Filed For tells the system how you want the communication record to display in CRM (default 

parameters for the information shown here are maintained in Settings) 

   

  If the email has attachments, the screen will change as follows: 

   

Private - sets the record to be private (only the user who filed it can view in CRM) 
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Attach Email as File - click to save the entire email as a .msg document in CRM 

Add Embedded Images - option to file embedded images to CRM 

Add Attachments - a list of attachments from the email is displayed – select the document(s) 

to be stored in CRM 

Insert Email Subject - default in Settings, but can be changed for each instance 

Insert Email Body - the full thread of the communication is displayed and will be saved 

Clear down - if previous emails have been saved in the thread, clear down is used to clean the 

text below the chosen point. Access clear down by right clicking – any text below that point is 

then truncated to display on the communication note record:  

https://www.screencast.com/t/VRjoWdipj 

b. Doc Settings 

Doc Settings allows you to specify the communication record attributes 

 

Note: File using Custom Fields must be selected in Settings for this tab to be populated. 
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If the email has attachments, the screen will change as follows: 

 

The fields displayed here can be customized to your CRM documents. 

3. Finding & Displaying Stored Emails 

The Accelerator quote bubble displays all communications associated with the email: 

 

Note: clicking on the communications symbol to the left of the summary will open the record in Sage CRM. 
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Outgoing Emails 
1. Assigning Sent Emails in CRM 

When there is more than one Person/Company associated with an email address, Accelerator will prompt 

you to choose the applicable record 

2. New Email 

a. CRM Search 

 

b. Accelerator Ribbon 

 

Send and File – this button will complete the same function as the standard Outlook Send button, but 

it will also file the sent email to CRM 

 CRM Address Book – use your CRM data to find email addresses by filter 
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Attach Global Documents – where there are CRM documents associated with a specific entity, they can be 

accessed from here and attached to an outgoing email 

 

Bookmarks – a selection of entities that have been favorited that can be used to dictate the context of 

an email and display the Accelerator pane within a new email 

 

My Contacts – accesses the same information that the My CRM – Contacts area contains 

 

History – calendar based record of your recent list in CRM for easy navigation  
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Templates – access the template you need to run your business and streamline communications 

  

 

Accelerator Information Menu 
1. Context-Specific Information 

 

Note: Data fields in green lettering indicate a hyperlink to either an executable function (e.g., website, 

email, phone call) or the corresponding entry in Sage CRM. 
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For example, by selecting the Person icon, a list of persons associated with this company appears. Click on 

the person icon for a contact and that person’s profile summary displays.  

By clicking on an opportunity in the list of opportunities, the Sales Opportunity Summary with all 

applicable details is displayed: 

 

The information offered is extended to include possible quotes and orders. By clicking on the 

corresponding icon, the overview list opens and the details are displayed. 

2. Bookmarks 

 

With this option turned on, you can add/remove bookmarks. Click on the star icon to add/remove from 

your list. If there is no star icon, this feature is not enabled. 
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Contact Us 
As you install Accelerator and begin utilizing the integration, questions may arise. Please contact us via 

inquiries@mycrmmanager.com and we will promptly respond. Be sure to include a screen shot of the 

question/issue so we can get a jump on the resolution.  

You can also contact the publisher directly at https://crmtogether.com/products/accelerator/. 
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